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This session recap includes the Q&A from the session. Additional information and links to more detailed content are 

included. 

Don’t forget to register for additional Ask the Expert: SAS Visual Analytics sessions. 

 

 

 

 

 

 

 

 

 

Question: Other than the obvious, what is the difference between the three map objects? 

Answer: By obvious I assume you mean how geographic locations are shown as bubbles, markers, 
and colored regions. As for the differences:  

 The Geo Bubble Map enables you to assign measures to the Size, Color, and Data Tip 
Values roles. You can also animate the map based on the values of a date variable. 

 The Geo Coordinate Map enables you to assign multiple measures that will be displayed 
as data tips. 

 The Geo Region Map enables you to assign measures for the Color and Data Tip Values 
roles.  

         
Additional  
Information: 

Geo Region maps do not support custom geography data items. 

   
 User’s Guide: Gallery of Report 

Objects: Geo Maps 

 User’s Guide: Working with Geo 
Maps 

 Create a Geo Map Report Object 

 Animate Graphs and Maps 

 More Than a Map: Location Analysis with 
SAS Visual Analytics 

 Discussion: Coordinates for Geo Map 

 

  

SAS Visual Analytics Toolkit 

▪ Product Overview 

▪ Getting Started Resources 

▪ Try the software yourself 

▪ Community 

▪ Free Video Tutorials 

▪ Documentation 

▪ Training 

http://support.sas.com/training/us/lw/lwrecord.hsql?date=08Sep14&ccode=19884
https://support.sas.com/edu/schedules.html?ctry=us&id=2243
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http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0dva9kxvxnw9en1ofben946kwwr.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1687i1a1vc6y7n1po1rpl6f9ldy.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1687i1a1vc6y7n1po1rpl6f9ldy.htm
http://support.sas.com/training/tutorial/va64/geo-map-report-obj.html
http://support.sas.com/training/tutorial/va64/animate-graphs.html
http://support.sas.com/resources/papers/proceedings14/SAS021-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS021-2014.pdf
https://communities.sas.com/thread/57062
http://www.sas.com/en_us/software/business-intelligence/visual-analytics.html
http://support.sas.com/software/products/va/index.html
http://www.sas.com/software/visual-analytics/demos/all-demos.html
https://communities.sas.com/community/support-communities/sas-visual-analytics
http://support.sas.com/training/tutorial/#s1=2
http://support.sas.com/documentation/onlinedoc/va/index.html
http://support.sas.com/training/us/paths/bi.html#va


Question: Can I view my reports in Excel? 

Answer: If you have the SAS Add-In for Microsoft Excel, you can view your SAS Visual Analytics 
reports in Excel, Word, PowerPoint, and even Outlook.  

Additional  
Information: 

SAS Enterprise Guide also enables you to view your SAS Visual Analytics reports. 

   
 SAS Add-In for Microsoft Office 

Help: Working with Reports 

 SAS Enterprise Guide Help: 
Working with Results: Working 
with Reports 

 Integrating SAS Office Analytics 
with SAS Visual Analytics 

 Share Your SAS Visual Analytics Reports 
with SAS Office Analytics 

 Everyday Visual Analytics 

 

Question: What's the difference between the Designer and the Explorer? 

Answer: The Explorer helps you learn about your data by visualizing it in different ways. The Designer 
enables you to present your findings in a report that you can view and interact with from 
several types of clients.  

Additional  
Information: 

Clients for viewing reports include the SAS Visual Analytics Viewer and the SAS Mobile BI 
app for iPad and Android tablets. You can also view your reports using other SAS 
applications such as SAS Enterprise Guide and the SAS Add-In for Microsoft Office. 

   
 User’s Guide: Exploring Data 

 User’s Guide: Designing Reports 

 Exploration Basics 

 Report Basics 

 The Forest and the Trees: See it All with 
SAS Visual Analytics Explorer 

 Get the Most Out of SAS Visual Analytics: 
Design Tips for Creating More Stunning 
Reports 

 Discussion: Explaining SAS Visual 
Analytics to Colleagues 

 

Question: I have got a report saved in the My Folder location.  A colleague and I will both need to work 
on the report. How can I give him access to the My Folder location I use? 

Answer: Your My Folder location is created as a secure place that only you can access.  By design, 
you won’t be able to allow your colleague to have access to your My Folder location.  
Instead, use a SAS Folder that you can both access.  If there isn’t an already created folder 
that you can both access, contact your SAS administrator to request one. 

Additional  
Information: 

 

   
 System Administration Guide: 

Working with SAS Folders 

  SAS Visual Analytics: Managing User 
Permissions 

 

http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/guide/index.html
http://support.sas.com/documentation/onlinedoc/guide/index.html
http://support.sas.com/documentation/onlinedoc/guide/index.html
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
http://blogs.sas.com/content/sascom/2014/03/07/everyday-visual-analytics/
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kco7sgodc9f7n1051ab8exs3kn.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p00vwuyiokyq1qn1k7jk5gntrrpp.htm
http://support.sas.com/training/tutorial/va64/va-explorer.html
http://support.sas.com/training/tutorial/va64/va-designer.html
http://support.sas.com/resources/papers/proceedings13/058-2013.pdf
http://support.sas.com/resources/papers/proceedings13/058-2013.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
https://communities.sas.com/docs/DOC-4112
https://communities.sas.com/docs/DOC-4112
http://support.sas.com/documentation/cdl/en/bisag/67481/HTML/default/viewer.htm#p1az7wj1xkvyqyn16526p7exxhyx.htm
http://support.sas.com/documentation/cdl/en/bisag/67481/HTML/default/viewer.htm#p1az7wj1xkvyqyn16526p7exxhyx.htm
http://blogs.sas.com/content/sgf/2014/05/21/sas-visual-analytics-managing-user-permissions/
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Question: In my report, I’ve got a crosstab table set up to show sales information.  I’ve also set up drop-
down lists for limiting the data shown in the table to a selected manager or employee, but 
they aren’t working correctly.  When I select a manager, the employee drop-down still shows 
employees for all managers and I want to see only the employees for the selected manager.  
How can I fix the drop-down lists so that I’ll see only employees for the selected manager? 

Answer: You’ll want to set up an interaction between the drop-down list for the manager and the drop-
down list for the employee.  And then you’ll also want to set up interactions from both drop-
down lists to the crosstab object.  After you do that, the drop-down lists and crosstab table 
should work the way you want. 

Additional  
Information: 

The control objects need to be placed on the report canvas, not in the section prompt area, in 
order to establish links. 

   
 User’s Guide: Working with 

Interactions 
 User Interactions and Links in a 

Report 
 Get the Most Out of SAS Visual Analytics: 

Design Tips for Creating More Stunning 
Reports 

 

Question: I’ve got a report already created for my product sales data and it’s working great.  Now I’ve 
got to create almost the same report but using supplier cost data.  Is there any way I can 
reuse my existing report with this different data table? 

Answer: There are several ways to reuse the existing report: 

 You can make a copy of the first report and then change the data source to the supplier 
cost data.  You’d change the data source by using the Change Data Source selection 
from the options menu on the Data tab. Data items that are not in the new data source 
will be removed from any report objects, so this method works best if the data items have 
the same name in the new table.  

 You can import report objects from the original report into a new report that uses the new 
data source.  That way you can select just some of report objects from the original report 
and not have to use them all.  You’ll still have to fix an imported report object that’s using 
a data item that’s not in the new data source. 

Additional  
Information: 

 

   
 User’s Guide: Working with Data 

Sources in Reports 

 User’ Guide: Base a New Report 
on Report Objects Imported from 
One or More Existing Reports 

 Create a Multi-Section Report 
and Import Report Objects 

 

 

Question: I want to filter all of my report objects the same way, including  those in another section. 
What's the best way to do this? 

Answer: You can use the Options button on the Data pane to create a data source filter. Data source 
filters subset the data for all objects in all report sections. 

Additional  
Information: 

An added benefit of using a data source filter is that a data source filter updates the 
cardinality values that appear on the Data tab. 

   
 User’s Guide: Working with Data 

Source Filters in a Report 

 User’s Guide: About Report 
Filters 

 Report Basics  

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1uqcf1ysblq4kn1rbcmw7cc66g9.htm
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http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
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http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/training/tutorial/va64/multsection-report.html
http://support.sas.com/training/tutorial/va64/multsection-report.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p146ddbi2wcokkn1ca3v8s5jfxpt.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p146ddbi2wcokkn1ca3v8s5jfxpt.htm
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http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p06et8z817thcvn1mm32zkdj8emv.htm
http://support.sas.com/training/tutorial/va64/va-designer.html


Question: I know that I can easily filter a report object by multiple data items, but both filter conditions 
must be met. Is there any way to create a filter where either condition can be met? An 
example is “year=2014 or rating>5”. 

Answer: You can create this type of report object filer by creating an advanced filter. With the report 
object selected, click the Filters tab in the right pane. Verify that Advanced is selected in the 
drop-down list and click Add Filter. Use the OR selection from the Boolean operators 
category when building your filter. 

Additional  
Information: 

    

   
 User’s Guide: Working with 

Advanced Filters 

 User’s Guide: About Report 
Filters 

  

 

Question: I have a pie chart, bar graph, and treemap that all show the same values such as country. 
How can I make the countries the same color in all of the graphs and have it automatically 
apply to new graphs in the same report? 

Answer: You can accomplish this by creating a report level display rule. Click the Display Rules tab 
in the right pane, select the report from the drop-down list at the top of the tab, and click New 
to create a new display rule. Add each country value to the rule and set the desired color. 

Additional  
Information: 

    

   
 User’s Guide: Add Report-Level 

Display Rules 

 User’s Guide: Overview of Display 
Rules 

 Create Display Rules  Usage Note: Support for display rules on 
specific report objects in SAS Visual 
Analytics Designer 

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kugett0xn3jgn11t9wfgzpixtp.htm
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http://support.sas.com/kb/49/684.html


Question: Why would I want to use the full screen report view instead of the tablet report view? 

Answer: The report view selection enables you to choose from Full Screen, Tablet, and Wide-screen 
Tablet. The default is Full Screen and enables your report to take up all of the available 
space in a browser window. Selecting one of the other choices enables you to design your 
report with a specific tablet size in mind to make sure that the report displays the way that 
you want it to when viewing it on a tablet. 

Additional  
Information: 

You can change the report view for the current report by 
selecting Report View from the View menu or by using 
the Aspect ratio button in the upper right corner of the 
report workspace. 

 
 
You can also use the Preferences window to set the report view that you want to use as the 
default for new reports. 

   
 User’s Guide: Choose a Report 

View 

 User’s Guide: Specifying Your 
Preferences for the Designer 

  

 

Question: Can you describe how comments work? 

Answer: Sure. Comments are a great way to add information to a report as well as to collaborate with 
your colleagues. You can add and interact with report comments in the Designer and from 
the Object Inspector on the Home Page. When using the SAS Visual Analytics Viewer or the 
Mobile BI app, you can create, view, and interact with report comments and you can also 
create, view, and interact with report object comments. You can add new comments, reply to 
existing comments, and even attach files to your comments. 

Additional  
Information: 

Report object comments cannot be added, changed, or viewed using the Designer or the 
Object Inspector on the Home Page. 

   
 User’s Guide: Add Comments to a 

Report 

 User’s Guide: Add Comments to 
Objects on the Home Page 

 User’s Guide: Add Comments to a 
Report in the Viewer 

 Export the Data Used in Report 
Objects and Collaborate Using 
Comments 

 Get Started with the SAS Visual 
Analytics Home Page 

 Discussion: SAS VA and comments 
limitations 

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n08btnbf8t7xygn1p0n9pazti6mr.htm
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http://support.sas.com/training/tutorial/va64/export-report-obj-data.html
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Question: I see description and keyword fields when I look at the report on the Home Page, but it 
always says "(not available)". How can I set these values? 

Answer: When you save a report, you 
select the SAS Folders 
location and enter a report 
name. You can add a 
description and keywords by 
selecting File  Report 
Properties in the Designer. 

  

Additional  
Information: 

You can also customize the Open window to show additional fields such as Description and 
Keywords.  Right-click the column headings on the right side of the Open window and select 
Customize. Select the fields that you want to display and click OK. 

 

   
 User’s Guide: View Report 

Properties 

  

 

Question: I would like to know if there are GEO maps for APAC values for a particular country, and can 
we display bubbles that include Lat/Long values? 

Answer: We have Geographical Lookup Table Values for SAS Visual Analytics 6.3 and 6.4. You can 
find them on support.sas.com. Select the link below:  
http://support.sas.com/rnd/datavisualization/va63geo/VA63LookupValues.html 
If the Lat/Long values are included in your data items, you can add these measures as a 
data tip value using the Roles tab in the right pane.  
 
 

Additional  
Information: 

We also have Country and Region Subdivision Lookup Table Values on support.sas.com as 
well. 
http://support.sas.com/rnd/datavisualization/va63geo/subdivs.html 
 

   
 User’s Guide: Geo Maps  Create a Geo Map Report Object 

 

 

   

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0unri03i0z5ecn1wlh0g5slu2nd.htm
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http://support.sas.com/training/tutorial/va64/geo-map-report-obj.html


Question: How do I add a filter that will filter all objects in a section? 

Answer: You can create a section prompt. Simply drag a control object to the Drop controls here to 
create a section prompt. You would then populate the control object with the data item that 
you want to filter. When you select a value from the section prompt, all objects will be filtered 
based on your selection. 
 

Additional  
Information: 

The 2012 Dashboard Section uses a button bar control object to filter all the gauges in the 
section.  

 

 
 User’s Guide: Working 

with Controls 

 
 Create a control report 

object 
 

   

 

Question: Can I export these graphs as a PDF file or PNG file? 

Answer: There is currently not a way to export graphs to a PDF or PNG file. However, you can export 
the Data Used in the report object. 
 

Additional  
Information: 

 

 
 User’s Guide: Exporting 

Data from Report Objects 

 
 Export the Data Used in 

Report Objects 
 

   

   

Question: When should one create / use a new aggregated measure versus a new calculated item? 

Answer: The choice of an aggregated measure versus a calculated item depends on how you want or 
need to use the new measure. The calculated data item is defined by an expression, and this 
expression is evaluated for every row when this data item is used in a report. An example of 
this type might be a profit value. The data values will be summarized in the report based on 
the summarization property specified in the data panel for the new calculated data item. The 
aggregated measure is not calculated until the data item is placed on a report. One example 
of this is a Percent by group. After the aggregated measure is added to the report, the 
grouping values are used to determine how the aggregated values are evaluated. 

Additional  
Information: 

 

   
 Work with Calculated Items in 

Reports 
 Create Calculated Data Items  

 Create Aggregated Measures 
in Designer 

 

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n148ej0xya6fr0n1wckjkmqgyilc.htm
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Question: In a demonstration, I saw the capability to link from one report section to another. As a part of 
this linking, the value of the bar in the bar chart that was selected was passed to the linked 
report. Does this type of linking take a lot to do? 

Answer: The actual linking setup is quite easy. Of course, the report has to include two or more 
sections, and the report objects need to be in place before the links can be established. To 
define the link, right-click the report object that you want to be the source of the link and select 
Add Link -> Section Link. In the Create Section Link window, you select the section in the 
report that you want to link to. Passing a parameter value is automatic with section links, you 
don’t have to make any other connections. It is just that easy. 

Additional  
Information: 

 

   
 Creating a Link  Report Enhancements  

   

Question: In a Geo Map report, can ZIP codes be used for the basis of mapping? 

Answer: One of the predefined set of Geo map values is the five-digit ZIP code. A column with the five-
digit ZIP values must be loaded into the SAS LASR Analytic Server, but once there, the 
predefined coordinate values can be used for display on a map. Simply right-click the ZIP 
code column in the data panel, select Geography, and then US ZIP Codes to apply the 
predefined values. A new geographical data item will be available in the data panel. After the 
map is created, the ZIP code can be included as a part of the data tip for display purposes. 

Additional  
Information: 

 

   
 Use a Geo Map  Create a Geo Map Report Object  

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0avi8j19qgkkun1q5znm94euwlk.htm
http://support.sas.com/training/tutorial/va64/va-designer-enhancements.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p08zq1v1bfz46an1frvdohjtjiap.htm
http://support.sas.com/training/tutorial/va64/geo-map-report-obj.html


Question: What are the different ways to load data into the environment?  

Answer: There are many ways that an administrator might load data into the environment. For this 
answer, let’s focus on the capability that might be available to an analyst working in the 
Designer. When the analyst selects from the Data tab, select a data source, and the Add 
Data Source window appears. If the analyst has provided the capability to load data directly to 
the SAS LASR Analytic Server from the Designer, then links are available on the right side of 
the Add Data Source window to Import Data, either Local data sources (SAS Data Sets, Excel 
worksheets, and so on), server data, or social media.   

Additional  
Information: 

 

   
 Import a Data Source for a 

Report 
 Import Data in the Designer  

 

If you have any questions, please contact: 

SAS Education Customer Service 
1-800-333-7660 
training@sas.com 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1wu8wfn7fpirfn1gsmmivteaku8.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1wu8wfn7fpirfn1gsmmivteaku8.htm
http://support.sas.com/training/tutorial/va64/import-data-designer.html
mailto:training@sas.com

